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Welcome to Vision

Welcome to Vision, an easy-to-use software solution designed to help you manage student 
computer activity in your classroom or lab. You use Vision to manage student computer 
use, share your screen with the class during instruction, and take control of a student’s 
machine to help with a problem. Unlike a computer screen projector, Vision does not 
require any special hardware or wiring; all you need to run Vision is a network connection 
between computers.

This guide explains the most common Vision features used to manage a classroom. Learn 
how to set up your classroom, connect to student computers, and begin incorporating 
Vision tools into your lessons and student evaluations. For more detailed or technical 
information about Vision, refer to Vision Help or the Vision 6 User Guide. For installation 
directions, refer to the Vision Quick Installation Guide.

What’s New in Vision6

Vision6 makes classroom management easier with the following new features.

Dashboard

A new dashboard interface that provides a snapshot of all the computers in your classroom 
while it offers intuitive and flexible controls to monitor and manage student computer use. 
The striking new appearance gives a clean, uncluttered, and dynamic interface which is 
easy to customize. Student computers can be displayed as thumbnails, from a classroom 
perspective, or in a list. You can drag computers to the new Monitor pane, to keep a closer 
eye on selected students while you supervise the entire class. And you can also drag the 
thumbnails in the dashboard to reflect the layout of your classroom.

Student Groups

Within a classroom, you can create student groups. You use groups to apply Vision 
features across a subset of students. For instance, you can demonstrate a procedure or lock 
the screen and keyboard for a group of students without affecting the rest of the class.
1



2 Welcome to Vision
Virtual Teacher

With Virtual Teacher, you can share a student’s computer desktop with a group of students 
or the entire class. From their computers, students can demonstrate or present to other 
students as well as to you. You decide who can become a virtual teacher and when the 
student presentation begins and ends.

Wireless Support

Vision6 includes a unique new communication algorithm designed specifically for the 
special needs of wireless networks. The Vision6 wireless technology is designed to 
overcome the potentially high rate of packet loss that can be experienced in wireless 
implementations. Vision6 supports both 802.11B and 802.11G wireless networks.

Remote Wake-Up

Vision6 is compatible with the Wake on LAN (WOL) industry standard technology to turn 
on computers remotely; from your desk you can turn on student computers that comply 
with the WOL standard.

Extended Classrooms

Vision6 supports communication across subnets and wide area networks. You can now 
teach in one computer lab to students in labs or classrooms across the school, the district, 
or the campus.

Mobile Lab and Laptop Support

A new connectivity model provides unlimited flexibility and ease of use in determining 
how your computer is connected to student computers in mobile lab and laptop 
environments. With the elimination of port dependencies, the connection between student 
computer and teacher computer is determined by you, not the student. You can easily 
connect and disconnect students from their computers whether those computers are 
laptops, wireless, on carts, or in fixed labs.

Open Enrollment

In those situations where you want to give students the ability to connect to a specific 
instructor's computer, Vision6 offers Open Enrollment. Use Open Enrollment to announce 
a class session over the network to which students can elect to attend. This is a perfect 
solution for colleges, businesses, or professional development classes where the student or 
attendee is fully capable of deciding if he or she wants to participate in the class.
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Technical Support
GenevaLogic offers a number of resources to help you make the most of Vision. When 
you need additional support, try one of the following.

Refer to Vision Help

Vision Help offers a number of step-by-step procedures for common Vision features. You 
can open Help from the Vision window or the dashboard. On the Help menu, click 
Contents.

Visit Our Web Site

Our Web site, www.genevalogic.com, offers a list of support resources, including 
Frequently Asked Questions, user documentation, and software updates.

Contact Our Technical Support Team

You can contact Technical Support through by phone, e-mail, or our Web site.

In North America All Other Locations

Phone: 866-725-7803 (toll free)

E-mail: support.us@genevalogic.com

Web: www.genevalogic.com

Our hours are 7:30 AM–4:30 PM
Pacific Time.

Outside of North America, the technical 
support of our products is provided 
through our international network of 
distributors and resellers. Please contact 
the local GenevaLogic distributor in your 
area. For a list of distributors, visit our 
international support page at 
www.genevalogic.com.



Setting Up Vision in the Classroom

About Classrooms
In Vision you use classrooms to organize a group of student computers you want to 
manage at one time. You can create a Vision classroom to represent a physical classroom 
or lab. You can also use classrooms to group computers at different locations, such as 
computer areas in a school library.

After you create a classroom and connect to it, you can begin to supervise student work, 
remotely control student computers, share screens, lock keyboards, and use other Vision 
features.

Create a Classroom

1. Double-click the Vision icon on your desktop to open the Vision window.

2. On the File menu, point to New and click Vision Classroom.
4
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3. In the Create new Vision Classroom window, enter the classroom name 
and any comments you want to add. Comments appear in the classroom 
properties.

• To allow students of the class to log on to classes at their own discretion, 
select the Open Enrollment check box. To learn more about Open 
Enrollment, refer to Vision Help or the Vision 6 User Guide.

• To make this classroom your default classroom, which is available from the 
My Vision Classroom icon on the desktop, select the Assign this 
Classroom to the My Classroom short cut check box.

4. Click Next.

5. Select the computers you want to add to the classroom. You can select 
computers in two ways. 

NOTE: If this classroom allows open enrollment, you cannot add computers 
from the network to the classroom.



6 Setting Up Vision in the Classroom
• Click Open Network to open a Windows Explorer window. Drag the 
computers you want to the Classroom computers box.

• Click Add to open the Enter computer names window. Type the names of 
the computers you want to include in your classroom and click OK.

TIP: To remove a computer from the classroom, select the computer in the 
Classroom computers box and click Remove.

6. Click Next, and then click Finish.
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Connect to a classroom and monitor student computers
After you connect to a classroom, you can monitor the computer activity of all student 
computers from the dashboard.

1. Double-click the Vision icon on your desktop to open the Vision window, 
and then double-click a classroom to open it.

2. From the toolbar, click the Connect Classroom button.

The student computer thumbnails change as the classroom connects to your 
computer.

Student computer is disconnected.

Student computer is connecting.

Student computer is connected. The student 
screen appears.
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To disconnect from a classroom

• To disconnect from a classroom and stop managing your students, click the 
Disconnect Classroom button.



Vision Toolbar and Windows

About the dashboard
The dashboard displays the active classroom on your computer. Using the dashboard, you 
can connect to the classroom and manage student computers.

1. Settings, Views, My Views and Special Commands panes

2. Classroom area (in Thumbnails view)

3. Monitor pane

4. Groups pane

21

4

3
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10 Vision Toolbar and Windows
To open the dashboard

• Double-click a classroom icon on your desktop or in the Vision window.

Working with Panes

You can adjust the areas or panes that border the classroom area on the dashboard (the 
Settings, Monitor, and Groups panes). You can keep the panes open or closed at all times 
or you can open the panes automatically when you point to the area of the dashboard 
where those panes are located.

To display or hide panes

• If you are using the Auto-Hide feature, point to a pane to open it. Point 
away from the pane to close it. 

• If you are not using the Auto-Hide feature, click the open and close buttons, 
which appear in the upper left or right corner of the pane.

To turn on or off Auto-Hide panes

• Select the Auto-Hide check box to open panes automatically when you 
point to them. 

• Clear the Auto-Hide check box to open and close panes when you click the 
open and close buttons.

These buttons open and 
close panes when you 
are not using Auto-Hide.

This check box controls 
how panes open and close 
in the dashboard.
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 To change the height or width of a window pane

• Point to the border of the pane, such as the Monitor or Groups pane. When 
the pointer changes into a double-headed arrow, drag the border to change 
the size of the pane.

Working with Student Computers
All the student computers in your classroom appear in the dashboard. From here you can 
easily apply any Vision task to the entire class. You can also apply an action to selected 
computers. For example, you may want to demonstrate a procedure to certain students 
who need help while other students continue working. Or you may want to shut down the 
computers in your class that are not in use. To do this, you first select the individual 
student computers you want, and then click the Vision command. 

To select one or more student computers

To select individual computers do one of the following: 

• To select a single computer, click it.

• To select consecutive computers, click in a blank area of the dashboard, and 
then drag your mouse pointer over the computers you want to include.

• To select nonconsecutive computers, press and hold down CTRL, and then 
click each computer you want.

• Point to a student computer and click the Check mark button. Do this for 
each computer you want to select.

Click this button to select 
a student computer.
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• Click on a group in the Groups pane. Groups are subsets of student 
computers that you create within a classroom. Instructions on how to create 
a group are below.

TIP: If you want to clear your selection of student computers, click in a 
blank area of the dashboard.

To Create a Group of Student Computers

1. On the dashboard, in the Views pane, select Thumbnails. 

2. In the Groups pane, click New Group.

3. Type a name for the group.

4. Select the computers you want to include in the group.

5. Click one of the selected computers and drag it to the new group. Vision 
adds all the selected computers to the group.

Notes

• You can also drag the computers you want to the Groups pane to create a 
group. 

• To add another student computer to an existing group, drag it to that group.

• To remove a computer from a group, point to the computer in Thumbnails 
view and click the Delete from group button.

Click this button to 
remove this computer 
from a group.
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About the Vision Window
The Vision window displays the classrooms that exist on your computer. Using the Vision 
window, you can create new classrooms and edit existing classrooms. For example, you 
can add a new student computer to a classroom or give a classroom a new name.

To Open the Vision Window

• Double-click the Vision icon on your desktop.

About the Vision Toolbar
The Vision toolbar appears at the top of your screen, on the Vision window, and on the 
dashboard. You use its buttons to start Vision features, such as Demo and Remote Control. 
If other GenevaLogic products are installed on your computers, programs such as Surf-
Lock or Pointer, the buttons for those add-in programs also appear on the toolbar.

About the Floating Toolbar

The toolbar at the top of your screen gives you an unobtrusive way to access Vision 
commands for the entire classroom. Without using the dashboard, you can easily start a 
demonstration or block student screens while you teach. Drag the toolbar anywhere on 
your desktop or customize it in any of the following ways to suite your needs. The changes 
you make are stored in your user profile and do not appear for other users.
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To Show or Hide the Vision Toolbar

• If you are using the Auto-Hide feature, point to the top of the screen to view 
the toolbar. Point away from the toolbar to hide it. 

• If you are not using the Auto-Hide feature, the toolbar remains at the top of 
the screen. Right-click the Vision toolbar, and then click Close the 
Shortcut Bar to remove it from your desktop.

To restore the Vision toolbar to your desktop

1. Right-click the Vision icon on your desktop and click Properties.

2. On the General tab, click Customize. 

3. On the Toolbars tab, select the Use Vision Shortcut bar check box.

4. Click Apply, and then click Close.

Add Toolbar Buttons

1.  Right-click the toolbar and select Customize. 

2. From the Customize Toolbar window, click the Vision icon in the 
Command Categories box.

3. From the Commands box, drag a command button to the toolbar. 

TIP: You can also drag a button to your desktop or the Start menu.

Remove Toolbar Buttons

• Right-click a button on the toolbar and select Remove Button.

Change Button Appearance

• Right-click the toolbar, and then click the option that you want to turn on or 
off.

• Show Big Icons increases the size of the toolbar buttons. 

• Text Labels displays names for each of the toolbar buttons.

To restore the Vision toolbar to its original look

• Right-click the toolbar, and then click Reset Vision.



Using Vision in Your Classroom

Below is an introduction to the basic Vision features you use to manage your classroom. 
Following the order of a typical class session, these procedures describe how and when 
you can include Vision in your lessons. If you have not already done so, create a 
classroom (see Create a Classroom on page 4).

Prepare for Class
Use Vision before your students enter the classroom. If your student computers support 
Wake on LAN (WOL), you can turn on (or ‘wake up’) all your classroom computers from 
your computer.

To turn on student computers remotely

1. Double-click the Vision icon on your desktop to open the Vision window, 
and then double-click a classroom to open it.

2. From the toolbar, click the Connect Classroom button.

3. On the Special Commands pane, click Wake up Computer.

NOTE:  If you are unable to start student computers remotely, contact your 
system administrator for information about the Wake on LAN 
compliance of your computers.
15



16 Using Vision in Your Classroom
Lock and unlock student computers
You can lock the computers in your classroom to prevent students from using them before 
class or during lecture. Vision displays a blank screen on the classroom computers and 
students cannot access their keyboards or mouse devices.

• On the Vision toolbar, click the Blank screen button. 

• To unlock student computers, click the Stop button. 

NOTE:  For information on how to apply Vision commands to individual 
computers, see To select one or more student computers on page 
11.

Lock and unlock student keyboards
You can lock student keyboards when you want students to see their computer screens but 
not have access to the keyboard or mouse.

• On the Specials Commands pane, click Lock keyboard.

• To unlock student keyboards, click the Stop button. 

Associate each classroom computer with a student
To help you match the computers on your screen to the students in your classroom, you 
can send a message that asks students to sign in. Students enter their names which then 
appear next to the computers in the dashboard. 

1. On the Vision toolbar, click the Request user name button.
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2. The Vision Enter user name window appears on each student computer.

3. Students enter their names and click OK.

Each computer is labeled with the name that the student typed. If a student 
does not enter a name or no one is sitting at the computer, the word Empty 
appears next to the domain name.

NOTE: You can also identify your classroom computers by computer name, 
student logon, or network address. On the View menu, point to 
Display name and click one of the following:

• Default displays the computer name stored in the computer's 
system properties.

• Login displays the user name the student entered when he or 
she logged on to Windows.

• Network address displays the Internet Protocol (IP) address.
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Screen Sharing
When you are connected to a classroom, you can share your screen with the entire class as 
you demonstrate a procedure or present information to your students. Unlike a projector 
that displays your screen to the front of the classroom, Vision projects your computer 
screen to the individual screens of your students. Students have a front row seat to your 
presentation no matter where they sit in the classroom.

Share your screen with the classroom

1. On the Vision toolbar, click the Demo button.

Your screen appears on the classroom computers and you can begin your 
presentation.

2. Click the appropriate button to change the size of the window that appears 
on the student screen,:

3. To turn off the demonstration, click the Stop button.

Full-screen Demo (default) maximizes the window so it covers the 
entire student screen. Student keyboards and mouse devices are locked.
Windowed Demo makes your screen another window on the student 
computers. Students have access to your screen, but are not required to 
view it; they have access to their keyboards and mouse devices.
Minimized Demo reduces the window to a button on the student 
taskbar. Students have access to your screen, but are not required to 
view it; they have access to their keyboards and mouse devices.
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Start a program on a student computer
From your computer you can start a program or open a Web site for your entire classroom, 
student groups, or for individual students. This feature helps students follow along with 
the lesson and keeps them on task.

NOTE: In order to use this feature, programs must be located in the same 
directory on both the instructor and student computers.

1. On the Vision toolbar click the Run application button.

2. Start a program or open a Web site in one of the following ways:

• Drag a program shortcut from the Start menu, or a Web address from a 
browser address bar, to the Open box. 

• Type (or cut and paste) the executable name of the program, such as 
Excel.exe for Microsoft Excel, or the address of the Web site.

• Click the down arrow to choose from a list of programs and Web sites you 
have used previously.

3. (optional) If you want to start the program or open the Web site on your 
computer, select the Run selected application locally check box. 

4. Click OK.



20 Using Vision in Your Classroom
Virtual Teacher: Share a student screen with the class
In the same way that you use the Demo button to share your screen with your class, you 
use the Virtual Teacher button to share a student screen with other students. This feature 
allows students to show their work to the class from their computers.

1. On the dashboard, click on a student computer to select it, and then click 
the Virtual Teacher button.

or

Click the arrow next to the Virtual teacher button and select the student 
computer you want. 

The selected student screen appears on the other classroom computers—
including yours—and those student keyboards and mouse devices are 
locked.

2. To turn off the student demonstration, click the Stop button.

Chat with your students
From Vision, you can conduct an online chat session with your students. This is useful 
when you want to conduct a discussion with part of your class without disrupting other 
students as they work. For more information about chat sessions and other features, refer 
to Chat Help.

To start a chat session

1. On the Vision toolbar, click the Chat button.

2. On the Chat menu, click New session.
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3. Enter a name for the session.

4. Select the students you want to include in the chat session from the 
Available users list, and then click the arrow button (>) to move them to 
the Selected users list. Next click Create.

5. Type your message in the chat window, and then press ENTER. Your 
students can also type messages and send them to you. As you continue 
your chat session, the Chat history area displays your discussion.

6. When you finish, click the End Session button.
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Send and collect files from students
You can send files to your students and later collect them. Distribute tests, forms, or 
assignments to students for a certain amount of time and then collect them automatically.

To send a file to students

1. On the Vision toolbar, click the Chat button.

2. On the Chat menu, click Send message.

3. Type your message and select the file you want to send your students. Click 
Browse to search for the file.

4. Select the students you want to receive the file from the Available users 
list, and then click the arrow button (>) to move them to the Selected users 
list.
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5. Click Send.

The students receive a message with the file attached to it. They double-
click the file to open it. 

NOTE: Students can also find sent files in their Vision work directories. Chat 
installs work directories by default at C:\Program 
Files\GenevaLogic\Vision\Chat\WFiles.

To collect a file from students

1. On the Vision toolbar, click the Chat button.

2. On the Chat menu, click the Collect button to gather the files on the 
student work directories and move them to your work directory. (Chat 
installs your work directory by default at C:\Program 
Files\GenevaLogic\Vision\Chat\WFiles.)

3. In the Collect Files window, indicate what should happen to the files after 
you collect them. You can delete the files from the student computers or 
leave them there. Chat then collects any student files that are stored in the 
Chat work files directory. 
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Monitor selected classroom computers
After you connect to a classroom, you automatically see the screen of every classroom 
computer. You can then select to monitor certain computers more closely in the Monitor 
pane. This is useful if you have a large class and want to pay attention to the students who 
need the most assistance or supervision.

To display a student in the Monitor pane

• Drag a student computer to the Monitor pane. Up to ten student computers 
fit in the Monitor pane.

To remove a student computer from the Monitor pane

• Click the Close button in the upper left corner of the student computer.

Notes

• You can change the rate at which computers in the Monitor pane are 
refreshed. If you do not select a refresh rate, Vision refreshes one screen 
every five seconds. For more information, refer to Vision Help.

Take remote control of a student computer
From the instructor computer, you can take control of a student computer in order to 
demonstrate a procedure, or to start or close a program for that student. Vision connects to 
the student computer and opens the Remote Control window, which displays the student's 
desktop. Use your mouse to control the student’s computer. The student does not have 
access to the mouse or keyboard while you have remote control of the computer, unless 
you grant the student access. 

To start remote control of a student computer

Do one of the following:

• Double-click a student computer.

• On the dashboard, select a student computer and click the Remote Control 
button.
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• Click the arrow next to the Remote Control button and select the student 
computer you want.

To stop remote control of a student computer

Do one of the following:

• In the Remote Control window, click the Stop mode button.

• In the upper-right corner of Remote Control window, click the Close 
button.

• In the Vision window, click the Stop button.
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Share a remote controlled student screen with the class
As you demonstrate a procedure on a student computer, you can broadcast your actions to 
the rest of the class. In addition, you can give that student computer access to the 
keyboard; you and your student can show a collaborative prensentation.

1. From the Remote Control window, click the Remote Control with Demo 
button.

The student screen you have control of appears on the classroom 
computers. All other student keyboards and mouse devices are locked.

2. Click the appropriate button to minimize or maximize the window that 
appears on the classroom computers.

3. (optional) To allow the student access to his or her keyboard and mouse 
while you have remote control, click the Disable remote user input 
button. 

4. To turn off the demonstration, click the Stop mode button.

Notes

• To make the student's entire desktop fit into the Remote Control window, 
click the Fit to window button.

Click the Full-screen Demo button to maximize the window so it 
covers the entire student screen. Student keyboards and mouse devices 
are locked.
Click the Windowed Demo button to make the screen another window 
on the student computers. Students have access to the screen, but are 
not required to view it; they have access to their keyboards and mouse 
devices.
Click the Minimized Demo button to reduce the window to a button on 
the student taskbar. Students have access to the screen and can resize or 
minimize it; they have access to their keyboards and mouse devices.
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• Click the High quality mode button to make details on the student screen 
easier to see.

Shut down student computers
From your computer you can shut down, restart, or log off students from the network. This 
is useful at end of the day or when your class no longer needs to use the computers.

1. On the Vision toolbar, click the Shutdown button.

2. Select the option to use when you shut down student computers.

•  Shut down the computer.

•  Restart the computer.

•  Close all programs and log on as a different user.

3. Select the check box Force applications to exit to close all programs that 
are running on the student computers.

NOTE:When you select this option students lose any unsaved data. For 
example, if a student has a Microsoft Word document open on her 
computer and you force all applications to quit, the computer shuts 
down without asking the student if she wants to save her changes.



Additional Vision Tools

Pointer and Surf-Lock are plug-in programs that you can use with Vision.You must have 
them installed on your computer in order to use their features. For information on how to 
purchase these programs, visit our Web site at www.genevalogic.com.

Pointer
You use Pointer to annotate text or graphics on your screen during instruction. During 
class demonstrations, you can draw attention to areas of your screen using one of over 20 
arrows, highlighters, and shapes. You can also zoom in and magnify any part of your 
screen or spotlight a particular object while the rest of the screen is dimmed.

Surf-Lock
Surf-Lock controls student access to the Web. Use this feature to remove the temptation of 
Web surfing during class time or reward students with access to the Web when they have 
completed their work. 

To make screen annotations

1. On the Vision toolbar, click the Pointer button.

2. From the Pointer toolbar, click the tool you want to use. For example, you 
can click the Highlighter button to change your mouse pointer to a 
highlight tool, which you use to draw on your screen. Or click the Arrow 
button to point out an area on your screen.
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3. When you finish, click the Erase button, and then draw a frame around the 
object you want to remove.

NOTE: For more information on the available annotation tools, refer to 
Pointer Help.

To lock and unlock access to the Web

• On the Vision toolbar, click the Surf-Lock button. 

Students cannot access the Internet.

• To turn off the Surf-Lock, click the Surf-Lock button again.
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